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1 What’s New 

Freescale’s CodeWarrior for Microcontrollers v10.5 integrates the development tools for the 

ColdFire
®
, ColdFire+, DSC, Kinetis, Qorivva, PX, RS08, S08 and S12Z architectures into a single 

product based on the Eclipse open development platform. Eclipse offers an excellent framework for 

building software development environments and is a standard framework used by many embedded 

software vendors.   

 

New device support:  

 Kinetis E Series: MKE02Z16, MKE02Z32, MKE02Z64 

 Kinetis K Series: MK21FX512, MK21FN1M0, MK22FX512, MK22FN1M0 

 Kinetis M Series: MKM13Z64, MKM14Z64, MKM14Z128, MKM32Z64, MKM33Z64, 

MKM33Z128, MKM34Z128, MKM38Z128 

 Qorivva: MPC5632M, MPC5633M, MPC5634M 

 S12Z: MC9S12ZVL8, MC9S12ZVL16, MC9S12ZVL32, MC9S12ZVLS16, MC9S12ZVLS32,  

 

Updated support for new silicon revisions: 

 S12Z: MC9S12ZVH64, MC9S12ZVH128, MC9S12ZVM32, MC9S12ZVMC64, 

MC9S12ZVMC128, MC9S12ZVML64, MC9S12ZVML128 

 

Major new features: 

 Modular installer only installs support for selected Freescale architecture(s) 

 Build tools, debugger, and Processor Expert performance improvements 
 Heterogeneous multi-core debug support for Qorivva and PX devices. 
 CodeWarrior Classic Project Importer available for CW DSC v8.3 projects 

 Kinetis MQX task-aware debug available in Special, Basic, Standard and Professional 
Editions 

 
Please note: CodeWarrior for Microcontrollers v10.5 is a full product release with a number of major 
enhancements. There are significant changes throughout the product, so updating a previous release 
to v10.5 is not practical. 
 

CodeWarrior for Microcontrollers v10.5 adds new features and addresses a number of defects. 

1.1 General 

1.1.1 Features 

 Moved to Eclipse 4.2.1 (Juno) and CDT 8.1.1. 

 Moved the main Debug toolbar to the global toolbar for improved usability. The 

previous toolbar locations can be restored by first toggling the Show Debug 

Toolbar option in the Debug view's menu, then by disabling the Debug toolbar 

from the Customize Perspective dialog. 

 Added ability to add Function Breakpoints to Breakpoints view 

 Consolidated Download, Attach and Connect launch configurations into a single 

launch configuration 

 New look for Launch Configuration Main Tab 

 Added two (2) new options for Launching the Main Application:  

o Disable program counter initialization  

o Disable application resume after download 

 Added support for chained errors 
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 Offline registers viewer imports hexadecimal text files 

 Jython scripting can be used to configure debugger related settings for CCS 

connections 

 Debugger Shell "config" command can be queried and has ‘–np’ option 

 Debug database indexer runs automatically after modifications are made 

 Added new option ‘Apply To Connection’ to quickly change the processor 

associated with a connection   

 Selected rendering formats are persistent for memory monitors  

 Performance improvements for debug session start:  

o First download and init file execution  

o Optimize parsing memory config file 

 Mixed Source memory rendering was removed since functionality is covered by 

Disassembly view 

 Added wizard to import register dumps 

 Added support for variables when configuring Path Mapping  

 Pressing Terminate without Suspend cancels trace collection and processing. 

 All Software Analysis results editors have the same look and feel as trace editor 

(title, header, tooltip). 

 CRCgen.exe, CRC utility, available for all architectures 

 Improved Processor Expert performance to increase IDE responsiveness. 

 Processor Expert provides ability to filter pin names in Component Inspector for 

all pin properties in all components, so a pin can be easily searched in a list. 

 Processor Expert provides F1 help and tool tip text for all Preference and 

Settings panels. 

 Updated MQX New Project Wizard to support both FSL ARM® compiler and 

ARM gcc compiler for Kinetis K Series devices. ARM gcc compiler is the default 

selection. 

 Fixed Processor Expert default event name, when adding new processor to a 

project.  

 Updated Processor Expert physical device driver (PDD) tooltips to contain 

possible enumeration values for enum arguments. 

1.1.2 Bug Fixes 

 ENGR00225384 – Processor Expert component help is dynamically generated 

from component html files and CPUs folders. 

 ENGR00237460,ENGR00241207 – Processor Expert added 'Delete' and 'F2' 

short-cut commands for user folders. 

 ENGR00256348 – When AnalogComp_LDD component is added to a project, 

Processor Expert adds one positive pin and negative pin.  

 ENGR00257040 – Processor Expert fixed issue which caused a deadlock when 

restarting Eclipse.  

 ENGR00258408 – Processor Expert added fixed prescaler support for serial 

device to fix timing calculation failures. 

 ENGR00259669 – Updated Processor Expert to remove empty/unused 

Events/ISRs from Event modules. 

 ENGR00259811 – Processor Expert added extra initialization blocks for UART 

registers BDH, BDL, C4, C5 to correct register ‘initialization values' configuration. 
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 ENGR00260780 – Processor Expert swapped order of register initialization for 

UART initialization sequence of UARTX_BDL-UARTX_BDH. 

 ENGR00263622 – Removed duplicate section 3.3.8.1 from 

ProcessorExpertHelp.pdf 

 ENGR00263910 – Processor Expert no longer invokes BeanInitialization CHG 

for new inherited components during project loading. 

 ENGR00265364 –Licensing plug-in updated to find license.dat file even if path 

includes white spaces. 

 ENGR00265547 – Processor Expert fixed exception, which occurred when 

adding indexed speed modes from include item during component creation. 

 ENGR00270094 – Processor Expert updated MQX component help to show how 

to use the component to build a MQX bsp library. 

1.1.3 Documentation 

 Common Manuals 

o CodeWarrior Common Features Guide for Microcontrollers V10.x Quick 

Start 

o Microcontrollers V10.x Profiling and Analysis Users Guide  

o Microcontrollers V10.x Targeting Manual 

o Microcontrollers V10.x Profiling and Analysis Quick Start  

 Processor Expert Manuals 

o Processor Expert User Manual  

o Processor Expert Components Manual  

o Component Development Environment User Guide  

o MQX Lite User Manual 

 Microcontrollers 10.x FAQ Guide 

1.2 ColdFire/ColdFire+ 

1.2.1 Features 

 Software analysis performs register cleanup to avoid resource conflicts with the 

debugger breakpoints when trace is disabled or debug session is restarted. 

 An error message is displayed and the current debug session terminated when 

P&E Mutlilink, Cyclone or Tracelink connections are disconnected unexpectedly. 

1.2.2 Bug Fixes 

 ENGR00163742 – Processor Expert added C++ support for ColdFire+ and V2-

V4 ColdFire architectures. 

 ENGR00216633 – New Project Wizard updated to use Processor Expert 

initialization function when generating C++ projects with Processor Expert for 

ColdFire devices. 

1.2.3 Documentation 

• ColdFire Assembler Manual  

• ColdFire Build Tools Reference Manual 

1.3 Digital Signal Controller (DSC) 

1.3.1 Features 

 Improved inline assembly support 

 Improved stability and usability of compiler 

 Improved generated debug information 
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 Added support for DSP56800EX instructions – IMPY32, IMPY64 and IMPY64UU 

 Added Processor Expert initialization, physical device driver static C (PDD2), 

logical device driver (LDD) and high-level component (HLB) support for 

MC56F823xx/7xx device family. 

 Software analysis performs register cleanup to avoid resource conflicts with the 

debugger breakpoints when trace is disabled or debug session is restarted. 

 An error message is displayed and the current debug session terminated when 

OS-JTAG, P&E Multilink and Cyclone connections are disconnected 

unexpectedly. 

1.3.2 Bug Fixes 

 ENGR00156843 – Processor Expert extended IntFlash component 

documentation and added version spec. information/code for DSC derivatives. 

 ENGR00226381: Fixed compiler issue which generated incorrect code when 

reading a word from a structure array located in external RAM addresses from 

0x8000 to 0xFFFF using the small data model. 

 ENGR00244555: Fixed inconsistent code generation for bit masking operations, 

generating optimized code for commonly used bit masking operations involving 

short data types. 

 ENGR00255410 – Processor Expert improved the error message when there is 

no external memory available in the selected processor component. 

 ENGR00265594 – Processor Expert has merged OCCS_OSCTL1[CLK_MODE] 

and OCCS_OSCTL1[ROPD] initialization sequence into one access to 

OCCS_OSCTL1 register for MC56F84xxx projects. 

 ENGR00266539 – Processor Expert now detects if the peripheral selected in init 

component is not listed in component database or component is not supported 

for the selected processor. 

 ENGR00266617 – Processor Expert fixed MC56F84789 clockgates properties in 

init component to allow PWM to be used for motor control. 

 ENGR00268133: Fixed DSC compiler issue for optimization levels 2 and above. 

 ENGR00273631: Replaced DSC trace decoder so trace is correct when using 

triggers. 

1.4 Kinetis 

1.4.1 Features 

 Added debugger, run control and FLASH programming support for KM1x and 

KM3x device families 

 Added debugger, run control, FLASH programming and Processor Expert 

support for K21F/K22F device family 

 Added debugger, run control, FLASH programming and Processor Expert 

support for KE02Z device family 

 DDR_Kinetis component in Processor Expert automatically checks the actual 

value of the DDR module's input clock. 

 DDR_Kinetis component in Processor Expert provides ability to generate a 

CodeWarrior debugger initialization file. 

 Added software analysis support for all Kinetis L devices 

 Added J-Link/J-Trace run control connection support for all Kinetis devices. This 

support includes unlimited Flash breakpoints. 
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 An error message is displayed and the current debug session terminated when 

P&E Microcomputer Systems and OS-JTAG run control connections are 

disconnected unexpectedly. 

 New Project Wizard updated to include bme.h header file in projects for Kinetis 

devices with the bit manipulation engine (bme). 

1.4.2 Bug Fixes 

 ENGR00163742 – Processor Expert added C++ support for Kinetis 

architectures. 

 ENGR00220626 – Processor Expert added DMA mode to ADC_LDD component 

for Kinetis L-Family. 

 ENGR00225194 – Processor Expert added new cpu function SystemReset() to 

allow software reset in a K70 project. 

 ENGR00226007 – Processor Expert added DMA setting to ADC_LDD 

component for Kinetis family. 

 ENGR00227619 – Processor Expert added DMA support in SPIMaster LDD and 

SPISlave LDD for Kinetis L-Family. 

 ENGR00258009 – Processor Expert DDR_Kinetis component checks PLL1 

value automatically instead of asking user to enter the value manually. 

 ENGR00258375 – Processor Expert DDR_Kinetis component generates an 

initialization file for CodeWarrior debugger. 

 ENGR00259793 – Processor Expert added a simple example of how to set the 

output value of a group of pins to the GPIO_LDD component's typical usage 

page. 

 ENGR00260000 – Processor Expert fixed Cortex M0 dispatcher in Stack 

Overflow Idle Task to correctly restore stack frame. 

 ENGR00260630 – Processor Expert added missing config bit for Kinetis K60 V2 

devices. 

 ENGR00262134 – Processor Expert enabled I2C Clock Stretching by adding a 

clock stretching property to select between empty character transmission and 

clock stretching if no characters are prepared for transmission by slave. 

 ENGR00263452: fixed ARM trace decoder so there is no difference between 

"trace" view and "Call Tree" view about function calls  

 ENGR00266232 – Processor Expert removed writes to reserved bits in 

SIM_CLKDIV1 for KL04Z32.  

 ENGR00271025 – Processor Expert fixed ADC reference selection for LQFP32 

packages on ADC_LDD component for MK10DX32VFM5. 

 ENGR00273067 – Processor Expert added missing SCB_CPACR register into 

debugger registers for Kinetis Cortex M4 devices. 

1.4.3 Documentation 

• Kinetis Assembler Manual  

• Kinetis Build Tools Reference Manual 

• Kinetis GCC Build Tools Reference Manual 

  



CodeWarrior Development Studio for Microcontrollers, v10.5 

 

 

September 9, 2013  7 

1.5 Qorivva/PX 

1.5.1 Features 

 Added heterogeneous mutli-core debugging for MPC5668x, MPC564xC and 

PXN20xx devices. Multiple heterogeneous cores can be debugged in the same 

debug session. The debugger has full control of all cores regardless of their type. 

 Improved stability and usability of build tools 

 Improved disassembly listing 

 Improved SPE2 support in build tools 

 Added Pragma read_only_vtable_RTTI  to allow the linker to place object code in 

ROM area instead of RAM.  

 Added automatic translation of classic 32-bit assembly instructions to mixed 16 

and 32-bit VLE instructions in stand-alone assembler using -ppc_asm_to_vle 

option 

 Introduced new linker option -gap_fill to fill the alignment gap created by address 

modifiers in s-record file  

 Modified Software Breakpoints so they cannot be set in read-only memory (e.g. 

Flash Memory) and cause bus errors. 

 Added debugger, run control and FLASH programming support for MPC563xM 

device family 

 An error message is displayed and the current debug session terminated when 

OS-JTAG and P&E Multilink and Cyclone connections are disconnected 

unexpectedly. 

 Updated license limitation error message to indicate the possible reasons 

(presence of C++ code or exceeded C code size limit) why the debug session 

ended. 

1.5.2 Bug Fixes 

 ENGR00241596 – Disallowed concurrent debugging of two different projects with 

mutli-core devices. It caused unpredictable results. 

 ENGR00257381– Solved deadlock that appeared when debugging MQX projects 

with Task Aware Debugging (TAD) activated. The deadlock happened when 

asserting Reset command from debugger. 

 ENGR00266747 – Fixed Multicore Resume issue when only one core was 

selected in Multicore Groups. 

 ENGR00268846 – Software Breakpoints are properly removed when debugging 

mutli-core devices. 

 ENGR00270709 – New Project Wizard updated to generate correct FlexCAN 

initialization code for MPC5643L, MPC567xK, PXS20xx and PXS30xx projects. 

1.6 RS08/S08 

1.6.1 Features 

 Software analysis performs register cleanup to avoid resource conflicts with the 
debugger breakpoints when trace is disabled or debug session is restarted. 

 An error message is displayed and the current debug session terminated when 
P&E Mutlilink or Cyclone connections are disconnected unexpectedly. 

 Added device unsecure functionality to P&E Multilink and Cyclone connections to 
support Target Task FLASH programming for previously secured S08 devices. 
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1.6.2 Documentation 

• HC(S)08/RS08 Assembler Manual 

• HC(S)08 Build Tools Reference Manual 

• RS08 Build Tools Reference Manual 

1.7 S12Z 

1.7.1 Features 

 Added register pre-assignment optimization. The build tools decide which local 

variables are more appropriate to live in registers and generate code / allocate 

registers according to pre-assignment decision. 

 Added stack access optimization. The build tools rearrange stack accesses to 

have accesses with higher frequencies at lower offset, which results in smaller 

code size. 

 Added extensions to constant propagation optimization (to better work with code 

generated using register pre-assignment optimization). 

 Added extensions to branch optimizations, including branch-to-branch and 

branch-to-rts optimizations. 

 Added optimization for compacting stack space by removing unused stack 

locations. 

 Modified Software Breakpoints so they cannot be set in read-only memory (e.g. 

Flash Memory) and cause bus errors. 

 Added Processor Expert support for S12ZVH device family 

 Added Processor Expert support for S12ZVM device family (mask set N59H). 

 Added debugger, run control, FLASH programming and Processor Expert 

support for S12ZVL device family 

 Added software analysis support for S12ZVFP and S12ZVHY device families 

 An error message is displayed and the current debug session terminated when 

P&E Mutlilink or Cyclone connections are disconnected unexpectedly. 

1.7.2 Bug Fixes 

 ENGR00256168 – Processor Expert added project examples for S12Z family. 

 ENGR00267538 – Processor Expert updated to allow COPCTL bits to be 

initialized by code generated by Init_COP or Watchdog component. This allows 

customer to initialize COP if either component is added to a HCS12XEP100 or 

S12Z project. 

 ENGR00268183: Replaced S12 trace decoder so correct trace is generated for 

code using 'bra' instructions. 

1.7.3 Documentation 

• S12Z Assembler Manual  

• S12Z Build Tools Reference Manual 

1.8 Component Development Environment (CDE) 

1.8.1 Features 

 Component name is independent of Eclipse project name. 

 New Component Editor allows easy modification of component structure tree on 

left side and details for each item on right side. 
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2 System Requirements  

2.1 Recommended Configuration 

 2.6GHz Pentium® compatible processor or better  

 4GB RAM  

 20GB (When installing full product or updates for all architectures) 

 400MB on Windows system disk  

 DVD drive for installation  

 USB port for communications with target hardware 

 Ethernet port for communications with target hardware (optional) 

2.2 Operational Minimum Configuration 

 1.8GHz Pentium® compatible processor or better  

 2GB RAM  

 20GB (When installing full product or updates for all architectures) 

 400MB on Windows system disk  

 DVD drive for installation  

 USB port for communications with target hardware  

2.3 Host Operating System Support 

 Microsoft® Windows XP 32-bit and 64-bit (Professional Edition) 

 Microsoft Windows 7 32-bit and 64-bit (Home Premium Edition and Professional Edition) 

 Microsoft Windows 8 32-bit and 64-bit (Home Premium Edition and Professional Edition) 

3 Product WEB page 

CodeWarrior Development Studio for Microcontrollers v10.5 is available for download at 

http://www.freescale.com/cwmcu10. 

4 Installation and Licensing 

To install CodeWarrior Development Studio for Microcontrollers v10.5, choose the download option 

that meets your needs. 

 

The online installer package contains the CW MCU v10.5 core tools and an installer, which assumes 

your computer has internet access. During the installation process the core tools will be installed and 

you will be asked to select the Freescale architecture support you want installed. The installer will 

automatically access the internet, download the necessary archives and install them in your 

CodeWarrior directory.  

 

The offline installer package contains the complete CW MCU v10.5 tool suite and an installer, which 

assumes your computer does NOT have internet access. All data needed by the installer will be 

downloaded and no other download will be performed. Double-click the installation package and a 

wizard will guide you through the installation process.   

 

 

http://www.freescale.com/cwmcu10
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An Evaluation license is automatically installed with your product and you do not need to register it. 

This license allows you to develop projects as Professional Edition during the evaluation period. 

After 30 days, the license works as a Special Edition license (free, permanent, but feature limited) 

which supports unlimited assembly code, up to 64KB of C code for S08/RS08, V1 

ColdFire/ColdFire+, Kinetis L Series derivatives; up to 128KB of C code for V2-V4 ColdFire and 

Kinetis K Series derivatives; and up to 512KB of C code for Qorivva and PX derivatives. 

 

New functionality including support for new devices and other FSL architectures can be added to 

CodeWarrior Development Studio for Microcontrollers v10.5 (CW MCU v10.5) with archives, service 

packs, updates and patches. Archives add support for other FSL architectures. Service packs add 

specific support for new devices. Updates and patches correct software defects and add general 

functionality affecting more than one device family.  

 

New support can be added directly from the Internet or from a downloaded archive. If your computer 

is connected to the Internet, select Install New Software in the Help Menu and all available updates 

will be displayed. If your computer does not have Internet access, you can download the archive that 

contains the service pack, update or patch you need from CW MCU v10.5 Update & Patches and 

follow the Service Pack Updater procedure posted on the site.  

 

Note: Before installing archives, updates, service packs or patches, select Restart in the File menu 

to perform a CodeWarrior restart. This will ensure all processes (e.g. debugger shell) are closed. 

CodeWarrior should NOT be used during the installation process. 

5 Technical Support  

All CodeWarrior issues are tracked through Freescale's normal Service Request Process. To report 

feature requests (enhancements) or defects for CodeWarrior Development Studio for 

Microcontrollers v10.5, please submit a Service Request.    

1. Go to http://www.freescale.com/support  

2. Log in.  

3. On the resulting MyFreescale page, click Enter a Service Request  

4. Choose category Software Product Support  

5. Choose topic CodeWarrior  

6. Click Next.  

7. Provide the required information. You may attach a file up to 10 MB in size to the SR. You may 

also specify email addresses of people you would like to keep notified on the progress of the SR. 

Separate multiple email addresses with commas. Depending on the nature of the issue (defects 

require more information) you may need to provide some or all of the information listed below. 

 Type:  pick from Question, Defect Report, Feature Request 

 Subject:  be short and descriptive 

 Description:  details your question, defect or feature request 

 Severity:  choose from Medium, High, or Critical 

 Target:  specify the hardware microcontroller/microprocessor family involved 

 Reproducibility: choose from Always, Rarely, Sometimes, Unknown 

 Steps to Reproduce: be precise so we can reproduce the problem 

 Expected Result: what you expected to happen 

http://www.freescale.com/webapp/sps/site/overview.jsp?code=CW_UPDATES_MCU_10_5
http://www.freescale.com/support
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 Observed Result: what actually happened 

 Product: CW for Microcontrollers 

 Root Cause/Nature: enter root cause (e.g. software defect) 

 RTOS: enter the RTOS being used (e.g. NA)  

 Major: 10 

 Minor: 3  

 Patch: N/A 

 Component: enter component (e.g. Debugger) 

 Host: enter host operating system 

 

Please note:  

The Product field must be set to CW for Microcontrollers. This will allow the appropriate 

Freescale personnel to find SRs related to this project very easily, follow up as needed, report on 

them, and gather statistics on how the product is doing.  

8. When finished, click Submit.  

After Submit is selected, a confirmation page will be displayed with the SR number. You will also 

receive a confirming email sent to the address specified in your Freescale account. 
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Appendix A:  Known issues and Workarounds 

Issue ID Description 

General  

ENGR00265303 Description: "Symbolics/Create and Use copy of Executable" breaks 
breakpoints in shared lib debug. When more than one executable is debugged 
with the same launch configuration (specified as other executables), the debug 
option 'Create and Use copy of Executable' cannot be used because 
breakpoints are no longer installed properly. 
Workaround:  Debug the original executables leaving option 'Create and Use 
copy of Executable' unchecked and manually kill the debugger whenever a 
rebuild is necessary. 

ENGR00265598 Description: When using "call by return" mechanism for calling functions in 
Performance View, a function will appear as if it has no children, and all its 
children will appear to be called from the function’s parent. 
Workaround:  None 

ENGR00274323 Description: Importing a breakpoint does not correctly set the breakpoint 
marker if the breakpoint refers an action that no longer exists. 
Workaround: For the import operation to work correctly, make sure there isn't 
a breakpoint set at the same line as the breakpoint being imported.  

ENGR00274667 Description: Find & Filter functionality does not work correctly in Software 
Analysis Trace Editors. 
Workaround: Find & Filter has been disabled for Software Analysis Trace 
Editors. The functionality is still available for Critical code and Performance 
Views. 

ENGR00276474 Description: Nothing happens when right click in CodeWarrior Projects View, 
select Import > Component Development Environment > Import from Package 
and click Next.  
Workaround: "Import from Package" and "Export to Package" commands 
cannot be run immediately after CodeWarrior is launched. The Processor 
Expert Service must be loaded first. To monitor the loading process open the 
Progress window (Window > Show View > Other > General > Progress). 

ColdFire/ColdFire+  

ENGR00236318 Description: Trace information captured with P&E Tracelink for MCF52259 is 
incomplete and inaccurate. 
 Workaround: Due to a hardware issue with MCF52259, trace does not 
operate properly with P&E Tracelink. Do not use Tracelink for data capture with 
this device. 

ENGR00258435 Description: Target Task flash programmer fails to calculate the correct 
number of sectors to erase before programming a MCF54418 external NAND 
flash.  
Workaround:  Modify the Target Task to erase the correct number of sectors. 

ENGR00272705 Description: Compiler generates incorrect code for a switch statement using 
enum variable when optimization level is more than one (1) and register 
coloring is enabled.  
Workaround:  The "enum" type should be forced to "int". 
1)  Select Project -> Properties -> C/C++ Build -> Settings -> ColdFire 

Compiler -> Language Settings -> Enum Always Int    
- Or - 
2)  Add command line option -enum int 
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ENGR00274320 Description: Target Task flash programmer crashes when trying to program 
data using an offset that is outside the device’s flash range (e.g. starting 
address or any subsequent address that goes outside the flash range).  
Workaround:  The offset is applied to all flash addresses - Base Address + 
Offset. Calculate the offset so all newly formed addresses are within the flash 
range. 

DSC  

ENGR00274320 Description: Target Task flash programmer crashes when trying to program 
data using an offset that is outside the device’s flash range (e.g. starting 
address or any subsequent address that goes outside the flash range).  
Workaround:  The offset is applied to all flash addresses - Base Address + 
Offset. Calculate the offset so all newly formed addresses are within the flash 
range. 

Kinetis  

ENGR00251403 Description: Timestamps greater than zero are reported in Trace Data View 
when Timestamps are disabled for ITM trace. The development platform is a 
Tracelink connected to a K21DN512 board. 
Workaround: None. When timestamps are disabled, the timestamps in the 
Trace Data View should be zero.  

ENGR00267162 Description: Wrong calculation when structure is packed using __attribute__ 
((aligned (1))) with optimization level greater than 2 using FSL ARM compiler. 
Workaround: Use Pragma to turn off load store optimization –  #pragma 
load_store_elimination off 

ENGR00277345 Description: The SE bit in the CMPx_CR1 register must be cleared to use the 
peripheral bus clock in Sampled Filtered mode.  Processor Expert allows you to 
select this mode in the Filter Mode property, but the generated code sets the 
SE bit in the Init method instead of clearing it. 
Workaround: Clear CMPx_CR1[SE] bit manually after Init function.  
1) Use PDD macro - CMP_PDD_EnableSampling(CMPx_BASE_PTR, 

PDD_DISABLE); 
- Or - 
2)  Write directly to register. 

Qorivva/PX  

ENGR00260637, 
ENGR00274574 

Description:  Software breakpoints do not work correctly on multi-core 
MPC56xx devices when a software breakpoint is set on one core while the 
other core is running. Due to software breakpoint corruption, the breakpoint on 
the running core is never activated. This only occurs when trying to debug two 
cores concurrently. 
Workaround:  Use hardware breakpoints, which work without limitations, when 
debugging two cores concurrently. Use software breakpoints when debugging a 
single MPC56xx core. 

ENGR00273161 Description: When debugging a MPC5675K/PXS30 project in LSM, the 
"Terminate and Remove" does not correctly terminate the debug session. 
Workaround:  
1) Use terminate and multi-core terminate commands 
2) Type "kill all" command in debugger shell to terminate the remaining cores. 

S08  

ENGR00274320 Description: Target Task flash programmer crashes when trying to program 
data using an offset that is outside the device’s flash range (e.g. starting 
address or any subsequent address that goes outside the flash range).  
Workaround:  The offset is applied to all flash addresses - Base Address + 
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Offset. Calculate the offset so all newly formed addresses are within the flash 
range. 

S12Z  

ENGR00274320 Description: Target Task flash programmer crashes when trying to program 
data using an offset that is outside the device’s flash range (e.g. starting 
address or any subsequent address that goes outside the flash range).  
Workaround:  The offset is applied to all flash addresses - Base Address + 
Offset. Calculate the offset so all newly formed addresses are within the flash 
range. 

Sensor  

ENGR00276212 Description: New Project Wizard does not generate an FXLC95000 application 
capable of booting from flash. 
Workaround:  
Change the following line in lcf file  
     code        (RX)  : ORIGIN = 0x00000000, LENGTH = 0x0001FFFFC 
to 
     code        (RX)  : ORIGIN = 0x000001D0, LENGTH = 0x0001FFE2C 
 
Change the following line in exceptions.c file 
    __declspec(weak) vectorTableEntryType _vect[115] = { 
to 
    __declspec(weak) vectorTableEntryType _vect[115] @0x0 = { 

MQX  

ENGR00270400 
ENGR00267677 

Description: M54418 MQX example project generates bus errors when 
reading/writing memory. 
Workaround:  

 Copy the content of the following file:  
<CW 10.5 installation directory>\MCU\ColdFire_Support 
\Initialization_Files\TWR-MCF5441X.cfg  

 Use it to replace the content of the following file:  
<MQX 4.0.x installation directory>\mqx\source\bsp\twrmcf54418\cw\dbg 
\twrmcf54418.cfg  

 Rebuild the BSP library. 
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Appendix B:  Freescale MQX™ RTOS Integration 

1 MQX 3.8 was developed to work with CW MCU v10.1. It is not supported in CW MCU v10.5. 

 

2 MQX v3.8.1 was developed to work with CW MCU v10.2. It has been tested and confirmed to work 

with CW MCU v10.5. 

 
3 MQX 4.0 was developed to work with CW MCU v10.2 and CW MCU v10.3. It has been tested and 

confirmed to work with CW MCU v10.5. 

 
4 MQX 4.0.1 was developed to work with CW MCU v10.4. It has been tested and confirmed to work 

with CW MCU v10.5. 

 
5 MQX 4.0.2 was developed to work with CW MCU v10.4 and  CW MCU v10.5. 

 

6 MQX Lite RTOS is integrated with CW MCU v10.5. It supports Kinetis L and K Series devices. To 

create a new project with MQX-Lite RTOS do the following: 

 

 Select New MQX-Lite Project in the Commander View. 

 Name the project. 

 Select a Kinetis device in the Devices dialog 

 Select a connection in the Connections dialog 

 Select preferred language and build tools options 

 A Processor Expert project will be created with the MQX-Lite component. 

 Configure the MQX-Lite component. 

 Add and configure other peripheral components to the project. 

 Select Generate Processor Expert Code icon in the Components View. 

 Add your application code to the project. 

  

7 MQX Task Aware Debugger is integrated with CW MCU v10.5 and is automatically installed. This 

plug-in can be used with all supported MQX versions (i.e. MQX 3.8.1, MQX 4.0.x and MQX Lite).  
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Appendix C:  Performance Considerations 

CodeWarrior Development Studio for Microcontrollers v10.5 is a powerful tool chain. The following 

suggestions will help keep the CodeWarrior tools running at a respectable performance level. 

 

1 To maximize performance, the CodeWarrior tools should be installed on a computer with the 

recommended system configuration. While the tools will operate on a computer with the minimum 

configuration,  the limited hardware will restrict its ability to function at desired performance levels. 

2 Close unused projects. Eclipse caches files for all open projects in the workspace. If you need 

multiple projects open, try to limit the number of projects to no more than 10. 

3 The Eclipse IDE provides several options that provide user assistance tools. These options, however,  

use memory and cpu bandwidth. If performance is slow and you do not need these options, turn them 

off.  

 Scalability options configure how eclipse deals with large source files. 

o Scalability options 

 Editor live parsing: impacts parsing while typing, Outline view, semantic highlighting, 

folding, etc. 

 Semantic highlighting: C/C++ identifiers are colored 

 Syntax coloring: coloring of keywords, comments and literals 

 Parsing–based content assist proposals: content assist proposals which require parsing 

the file  

 Content assist auto activation: content assist activated automatically on trigger 

sequences, like '.', '::' or '–>'. 

o To disable: 

 Click menu ‘Windows’ –> ‘Preference’  

 Expand ‘C/C++’ –> ‘Editor’ –> ‘Scalability’ 

 Uncheck ‘enable scalability options’ 

 Content Assist Auto Activation can reduce the number of keystrokes a developer must type 

to create code. The Content Assist plug-in consists of components that predict what a 

developer will type, based on the current context, scope and prefix. 

o To disable: 

 Click menu ‘Windows’ –> ‘Preference’  

 Expand ‘C/C++’ –> ‘Editor’ –> ‘Content Assist’ 

 Uncheck all the options for ‘Auto Activation’  
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